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Incident 
# 

Prob 
Type 

Description Assigned Project 

51844 EN Maestro Message Integration with an Email Application                5.1.022 

Based on a new system option, Maestro Messaging (Trace Messages, Clerk 
Messages and Auto Generated Messages such as Password Changes) can now 
be sent to an email application.    

During each Night Audit, Maestro will review all traces that are marked as Unread 
and Undone, that are due the following day by user and send all traces via an 
email message to that clerk.  The Clerk Code must have a valid email address on 
the Clerk Extra Information Screen.    

GB 

51980 EN SMS Generated Alert Messages                                                      5.1.024 

SMS Generated Alert Messages may now be configured for Staff Members with 
any Maestro Messages, Group Guests with any message and Guests belonging to 
a particular Guest Type or Rate Type.   

GB 

52129 EN Ability to send Language Specific eForms                                       5.1.018 

A new option on the Email Setup screen now allows the user to set the entire 
eForm system to be language specific.  If no option is filled in, Maestro will 
continue to send emails as expected.  

If the new option is turned on, eForms must be created for all valid languages.  
Languages are based on the Client Language Preference entered on each Client 
Profile.  An eForm must then exist for all valid form languages as well as for a 
“Blank” Language to capture all profiles where a language has not been selected.  

GB 

52179 EN Wild Card and Soundex Search Options for Guest Names                 5.1.015 

The ability to perform a “Wild Card” Search from any Guest Name Look Up Screen, 
Reservation Look Up by Last Name, Guest History Profiles, Switchboard and the 
Dashboard.   When using the Wild Card Search, users may enter a wild card 
character of * to replace many characters or may enter a ? to replace one 
character. 

For example, using a Wild Card Search with a * for Mc*, will return all guest names 
that start with Mc regardless of how they end.  If a Wild Card Search with a ? was 
used for Mc?, Maestro would only return any guest names that were three 
characters long starting with Mc.   

The Soundex feature must be selected on the Search Screen.  When in use, 
Maestro would return values that have the same phonetic sound.  For example, if a 
Soundex Search was done for Smith, the Search results would return Smith, 
Smithe, Smythe, etc. 

Soundex and Wildcard Searches may be used together however only the Guest 
Name field should be used when performing this search.  No other criteria should 
be entered.  

GB 

52383 EN Advanced Housekeeping Management for Multi Property                5.1.025 

Maestro now supports allowing housekeeping to manage all rooms for all hotels as 
though they were a single property.  A new system option must be turned on for 
this new feature.  

If this new feature is turned on, the Housekeeping Display Screen, Room 
Assignment Screen and Housekeeping Reports will show all rooms for all 
properties.  All Maintenance Programs still require property specific Service Plan 

GB 
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configuration. 

52384 EN Housekeeping Cart Inventory                                                                 5.1.029 

A new configuration option is now available to setup a ‘list’ of inventory and 
supplies required when cleaning each room.   Items are based on the Room 
Number, the type of service and the number of guests in the room. 

When in use, the Housekeeping Assignment sheets will show a summary of items 
required to be on the Housekeeper’s Cart to clean all assigned rooms. 

Setup can be completed either from the Housekeeping Configuration Screen or by 
using the “Contents” Pulldown menu in Global | Setup | Buildings/Rooms. 

GB 

52175 EN “Contact Us” Information under the Help Menu                             5.1.015 

A new option has been added under the Help Menu in each Maestro screen, called 
Contact Us.  When selected, users will see the Main Maestro Number and Maestro 
Support contact information.    

GB 

52331 EN New Reports in CSV File Format / Able to be Emailed             5.1.027 

Two new reports have been created under the Management Reports Menu in 
Maestro for “Revenue to Budget and Pace” and “Call Production Report”.  These 
new reports require setup to generate in .CSV file that can be emailed.   Email 
addresses can be setup for both Night Audit Report printing and Contingency 
Report printing.  When the option for Email is chosen, no report will print to a 
printer.  

GB 

52402 EN Default Business Date – Calendar vs. Audit Date                                  5.1.024 

A new global option is now available to allow properties to control whether the 
current business date is the audit date or the calendar date.  For additional details 
on this feature, please contact a Maestro Team Member.  

GB 

51067 EN Option to Show Just Vacant Ready Rooms During Check In  5.1.018 

A new Filter has been added to all Room Number Available Screens to allow the 
user to input a Room Status to display.  If entered, only rooms matching the criteria 
will be displayed, if no value is entered, Maestro will display all rooms that are 
expected to be available when the guest arrives.   

FD 

51920 EN Additional Room Details on Switchboard Screen                     5.1.020 

The Switchboard Screen has been enhanced to include additional room details 
including Full Room Type Name, Description, Extensions and Default Phone Line 
Type.  In addition, the screen size has also been expanded to show more Search 
Results at one.  

FD 

51925 EN Ability to Reverse Check Ins                                     5.1.018 

Front Desk Individual Guest Reservations that are Checked In may now be 
reversed on the arrival date based on a new authorized function (FD | RCI).  The 
reservation will revert back to a Reserved Status when the Un Check In Option is 
used.  

FD 

51926 EN Ability to Check In All Sharers Assigned to Room on Arrival Day 5.1.018 

A new system option has been created to determine how to handle Sharer 
Reservation Check Ins.  If the new feature is turned on, once the first Sharer has 
been checked in, Maestro will ask the user if they wish to Check In all Sharers for 
that room who are Arriving today.  If the User selects Yes, Maestro will proceed to 
Check In each sharer reservation using the established Check In process until all 

FD 
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sharers for that day have been Checked In.  

51879 EN Rooming List Import from Excel Spreadsheet                                 5.1.011 

Maestro now supports the ability to import Rooming Lists completed on an Excel 
Spreadsheet based on a specific spreadsheet criteria.  For additional information 
on this feature, please consult a Maestro Team Member.    

FD 

51881 EN Override Dirty Room Status at Check In                                         5.1.015 

A new system option has been created that allows the ability for a Manager with 
appropriate permission to allow a Check In to a not ready room.  

FD 

51883 EN Hold Room Assignments Until Room Move Completed  5.1.007 

When moving room assignments, users may now place a hold on all rooms 
involved in a selected room move to prevent the loss of rooms involved in the room 
move, to be lost to other reservations begin made.   Rooms may be placed On 
Hold during the room move and then can be “Unheld” once all moves are 
completed and the rooms are no longer needed.   

FD 

51882 EN Swapping Rooms Assigned to Two Reservations   5.1.011 

A new option is now available from the Room Tape Charts to allow users to Swap 
an assigned room on one reservation with another assigned room on another 
reservation.  The new Option for Move / Start Swap allows the user to “tag” one 
reservation and then “tag” another reservation which indicates to Maestro to swap 
the room numbers assigned if criteria are met.   

 This feature currently works for swapping Two Reserved Rooms that are assigned 
to Arriving Reservations.  Both Reservations must have the same arrival and 
departure date.  Suites cannot be moved this way currently.   

If a reservation, to be swapped, is part of a Group and the assigned Room Types 
are different, the block will be adjusted by adding the new room and subtracting the 
old room to ensure the overall block does not change.  

FD 

52173 EN Group Guest Room Swap from Rooming List                            5.1.015 

From the Window Menu in the Group Rooming List Screen, users may select the 
“Swap Room List” menu option.  This feature will allow users to swap rooms for all 
group members arriving and departing with the main group block including the day 
of arrival, prior to Night Audit.  

When the Swap Room list option is selected, Maestro will ask the user to confirm 
the date range and then present a Swap Room screen to swap one or more 
reservations by room type or room number.  

FD 

51929 EN Waitlist Room Types / Numbers for In House Guest Reservations     5.1.023 

A new system option is now available to allow In House Guest Reservations to 
have a “waitlisted” room also assigned when the room that the guest requests is 
currently in use.  

The guest reservation must be checked into a room type and room number and 
must be In House.  A room or rooms can be ‘waitlisted’ on this guest reservation 
indicating a room move preference or request.   

If a room remains “waitlisted” on an in house reservation,   no charges will occur 
during the Night Audit for the Waitlisted Room and the “Waitlist” will remain in place 
for all additional days of the guest or room request.   

Dynamic Package rates may be used however all Forced Items will remain 

FD 
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“Unbooked” and can only be booked when the inventory is confirmed.  

52097 EN Ability to Block Group Components from Group Master  5.1.020 

When using Maestro’s integrated Spa & Activities module, users may now block a 
specific number of Spa appointments based on the Rate Type associated with the 
Group Master, based on dates of stay and available times. 

Two new menu options are now available from the Inventory Pull Down Menu 
within the Group Master.  

“Group Components Display” allows users to easily see the components that make 
up the assigned Group Rate including available days and upgrade pricing which 
allows the user to audit the assigned rate for accuracy.  

“Group Block Spa Time Slots” provide the user with an entry screen based on the 
assigned Dynamic Rate Type, to block a specific number of Services by Time Slot. 

FD 

51384 EN Dynamic Package Template Activities Booking                      5.1.007 

When a Dynamic Package Template is created with one or more 3
rd

 party Activities 
assigned, Maestro now validates the selected activity at the time of booking and 
will prompt the user if they attempt to book an activity for a day not included in the 
Template.  Users may choose to still book this item and it will be included in the 
package.  

FD 

52045 EN Setup Display on Single Day Function Room Availability Screen 5.1.020 

A Toggle Button has been added to this screen to allow Users to view Booking 
Name Display (as it is currently) or by Setup Style Display.   If subevents in the 
room have different setup styles, the setup description on screen will change when 
the new subevent starts.  

SC 

52454 EN Assigning Health Attributes to Client Profiles in Spa                          5.1.033 

Users may now drill down to attach Heath Attributes to a Client Profile from the 
following screens: 

- Service Booking Entry Screen 
- Services by Day – Quick Book 
- Provider Bookings – Quick Book 
- Guest Service Booking List 

CM 

52258 EN Reorganization of Member Reports                                5.1.031 

All Member Reports have been relocated to the Reports Menu from the Member 
Menu.  

Additionally, the Ledger Report has been renamed “Member Ledger Report”  

CM 

52257 EN Additional Details on the EFT Member Folio Details Screen  5.1.032 

Additional Details have been added to the EFT Member Folio Details Screen 
including: 

- Billing Transaction Date 
- Posting Code 
- Posting Code Description 
- Profit Center 
- Clerk Code (the clerk who performed the billing) 

CM 

52256 EN Enhanced EFT Member Billing with F&B Credits                                  5.1.031 

Maestro configuration now supports the ability to setup and apply Food and 

CM 
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Beverage Credits.  Credits and Debits for F&B are applied based on a specific 
profit centers associated with each posting code.  For additional details, please 
consult a Maestro Team Member. 

52261 EN Member Pre-Billing Report                                                            5.1.031 

A new report for Member Pre-Billing is now available from within the Generate EFT 
screen to ensure accurate EFT billing.  The report lists all Members with a current 
balance, F&B purchased and F&B Credits. 

CM 

52262 EN Member Unused F&B Credits Report                                               5.1.031 

A report listing all Member Unused F&B Credits can now be found under the 
Report Menu in Spa & Activities.  

CM 

52265 EN Expired Members Report                                                     5.1.033 

This new report provides details for Members whose Membership has or will be 
expiring based on the date range selected.  This report can be run from the Report 
Menu in Spa & Activities.   

CM 

52222 EN Ability to Select AR Settlement Folio for Service Booking    5.1.024 

Within the Service Booking screen, users may now Search by Folio Number as 
well as by Account Name.  The appropriate A/R name, once selected will display in 
the A/R Client Code field for the Service Booking.   

CM 

52158 EN Restrict Table Reservations by Volume per Hour                                  5.1.015 

A new feature has been added to the Table Reservations module to allow users to 
control the maximum number of reservations and seats by hour.  This allows user 
to setup a max capacity by hour for reservations that are arriving to be seated.  

Additionally cursor handling on this screen has been updated to no longer allow a 
Blank Restaurant Location. 

PS 

51979 EN Active Gen Interface Support for HTNG 2008B                              5.1.003 

Active Gen Interface Setup now allows specification for the correct HTNG standard 
with two options:  2008A and 2008B.  Based on the option selected, the XML 
messages will be constructed with the appropriate HTNG nameset. 

INT 

52124 EN CC Settle by Field now Optional in ResWave                                     5.0.011 

A new field for the credit card Settle By Flag has been added to the ResWave 
setup to set a default value of Y or N to be used when making on line reservations. 

INT 

52290 EN Expanded Revenue Field in the GL Export                                     5.0.024 

The Revenue Field in the GL Export has been expanded.  

INT 

 

52511 EN Ability to Import Historical Room Rev, Nights and Pace                    5.0.033 

A new import feature has been created to allow the historical import of room 
revenue, room nights and pacing into Maestro. 

INT 

52125 SW ResWave Room Type Groupings by Property                                     5.0.018 

Room Type Groupings setup for ResWave now show properly on screen by 
property 

INT 

52376 SW ResWave Sort Order Options                                                           5.1.033 

Sort Order Logic for Sort Options 7 and 8 have been updated. 

Option 7 sorts by Room Number assignment Order, then Rate Type, then Total 

INT 
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 Amount. 

Option 8 sorts by Room Number assignment Order, then by Total Amount, then by 
Rate Type. 

52394 SW Computer Date Change Allowed Audit for Future Date            5.1.033 

In previous versions if a user changed the computer date to a Future Date, 
Maestro would allow the audit to run for the future date.  A new system option now 
exists to ensure that the audit can only be run for one day at a time based on the 
last audit date.  

GB 

52217 SW Default Folio Settlement Method when Batch Transfer Used            5.1.018 

When a Batch Folio Transfer is completed, Maestro will now verify and use, if 
configured, the Default Folio Settlement Method in Front Desk Maintenance 

AR 

52312 SW Folio Detail Screen Transfer Handling                                      5.1.022 

In previous versions of Maestro, if a user was transferring or reversing a 
transaction posted on a Closed Folio, Maestro was automatically transferring the 
first line when the Folio was “Reopened”.  This has been corrected.    

AR 

52287 SW Services Rate Chart Provider Display                                      5.1.029 

The filter for Provider on the Services Rate Chart now displays Providers based on 
Service Type / Service selected just as the Services by Day Screen.   

CM 

52321 SW Retail POS Cost Analysis Report Totals                              5.1.023 

This report has been updated to ensure that all Retail POS Item amounts and 
prices are reported correctly. 

CM 

52325 SW Proforma Folio Tax Exemption Handling                                               5.1.035 

The Proforma Consolidated Invoice was incorrectly reporting taxes for Tax Exempt 
Group Masters.  This has been corrected.  

If Charge Routing is used, the Tax Exemption Rules for the Guest will be used. 

If the Group Post Flag = Y or R, the Tax Exemptions for the Group Master will be 
used.   

SC 

52394 SW Single Day Function Room Availability                                        5.1.029 

When drilling down from the GRC Screen, via the Availability Button, Maestro now 
correctly displays all function rooms within all Buildings for the property. 

SC 


